
Chapter 1

Exploring CINEMA 4D 
R15 Studio Interface

 Learning Objectives 
After completing this chapter, you will be able to:
• Work with Viewport Navigation Tools in CINEMA 4D
• Understand various terms related to CINEMA 4D interface
• Work with tools in CINEMA 4D
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INTRODUCTION 
MAXON CINEMA 4D R15 Studio is a high-end 3D application developed by MAXON 
Computer.  This application is used by professional 3D artists to create impressive 3D scenes, 
VFX, and broadcast artwork. CINEMA 4D comes in four versions: Prime, Visualize, Broadcast, 
and Studio. CINEMA 4D Prime is used to create stunning 3D graphics. CINEMA 4D Visualize 
provides fast and easy solution to architects, designers, and photographers to create realistic 
animations and for product visualization. It also has the ability to import models from all 
major 2D and 3D file formats. CINEMA 4D Broadcast is a perfect solution for creating high 
quality broadcast graphics. CINEMA 4D Studio contains all features of CINEMA 4D Prime, 
CINEMA 4D Visualize, and CINEMA 4D Broadcast. Moreover, it includes character animation 
tools that makes it easier for its users to create rigs and character animations. 

MAXON CINEMA 4D is a user-friendly application which is used for sculpting, creating 
particles using advance particle system, hair system, and for creating motion graphics using 
MoGraph. In this chapter, you will be introduced to MAXON CINEMA 4D Studio R15 
interface elements.

STARTING MAXON CINEMA 4D R15 Studio
To start MAXON CINEMA 4D R15 Studio, choose the Start button on the taskbar; the Start 
menu will be displayed. Next, choose All Programs > MAXON > CINEMA 4D from the Start 
menu, as shown in Figure 1-1. The default interface of MAXON CINEMA 4D R15 Studio will 
be displayed, as shown in Figure 1-2.

Figure 1-1  Starting MAXON CINEMA 4D R15 Studio from the Start menu
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Figure 1-2  The default interface of CINEMA 4D  R15 Studio  

EXPLORING MAXON CINEMA 4D R15 Studio INTERFACE
CINEMA 4D interface consists of various components such as title bar, Viewport, Command 
Palette, Modes Palette, main menu, and so on, as shown in Figure 1-3. All these components 
are discussed next. 

Viewport
Viewport is that part of the work area where you can create a 3D scene. Every viewport has a 
grid placed at the center. A grid is a framework of intersecting lines placed perpendicularly 
in the X-Z plane. At the center point (origin), the X, Y, and Z coordinates will be 0, 0, and 0, 
respectively. 

Note
In CINEMA 4D, the X, Y, and Z axes are displayed in red, green, and blue colors, respectively, 
refer to Figure 1-3.

When you start CINEMA 4D, the Perspective viewport is displayed by default, as shown in 
Figure 1-3. This viewport displays objects from a perspective camera. You can also display other 
viewports such as Top, Right, Bottom, and Front in the work area. These viewports display 
objects from orthographic camera view and do not display the perspective view. To switch to the 
4-view viewport arrangement, hover the cursor over the Perspective viewport and then press 
the middle-mouse button once. If you need to maximize any of the four viewports, hover the 
cursor over the viewport you need to maximize and then press the middle-mouse button once.
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               Figure 1-3  Various components of CINEMA 4D R15 Studio interface

Title Bar
The title bar, located at the top of the interface, displays the name and version of the software, 
and the name of the opened file. A CINEMA 4D file is saved with the .c4d extension. 

Tip: You can display different viewports by using the functional keys: F1 (Perspective), F2 
(Top), F3 (Right), F4 (Front), and the F5 key (for all viewports). 

Main Menu
The main menu is located just below the title bar, as shown in Figure 1-4. The options in this 
menu are used to access tools, functions, or commands in CINEMA 4D.

   Figure 1-4  The main menu

Command Palette
The Command Palette is located below the main menu, refer to Figure 1-4. It is used to 
invoke the most commonly used tools in CINEMA 4D. The tools in the Command Palette 
are discussed next.

Undo
The Undo tool is used to revert the last action performed in the scene. By default, the 
user can undo maximum of 30 changes.
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Tip: You can increase or decrease the undo limit. To do so, choose Edit > Preferences from 
the main menu; the Preferences dialog box will be displayed. In this dialog box, choose 
Memory from the list of options on the left of the Preferences dialog box; the Memory area 
will be displayed. In this area, enter the required value in the Undo Depth spinner.

Redo
The Redo tool is used to revert the last action performed by the Undo tool. The number 
of redo actions cannot exceed the number of times a change is made.

Live Selection
The Live Selection tool is used to select objects in the 
scene. You can also select elements (points, edges, and 

polygons) using this tool. It works like a paint brush where 
the user paints over points, edges, and polygons to be selected. 
When you press and hold the left mouse button on the Live 
Selection tool, a flyout will be displayed, as shown in Figure1-5. 
The various types of selection tools in this flyout will be 
discussed in the later chapters.

Tip: You can interactively change the size of the Live Selection tool’s brush by pressing 
and holding the middle mouse button and then dragging the cursor to the left or right.

Move
This tool is used to move an object in the viewport, provided the axes are not locked. 
Moreover, this tool is used to select points, polygons, and edges by clicking on them. 
You can increase the selection by pressing and holding SHIFT and then clicking on the 

elements. You can also remove elements from the selection by pressing and holding CTRL 
and then clicking on the elements.

Scale
This tool is used to scale an object in the viewport. 

Rotate
This tool is used to rotate an object in the viewport. 

Active Tool
This tool displays the icon of the last used tool.

X-Axis / Heading
This tool is used to lock or unlock the transformation along the X axis. If this tool is 
chosen, the object will not move, scale, or rotate along the X axis. The shortcut key for 
invoking this tool is X.

Figure 1-5  Flyout displayed on 
choosing the Live Selection tool
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Y-Axis / Pitch
This tool is used to lock or unlock the transformation along the Y axis. If this tool is 
chosen, the object will not move, scale, or rotate along the Y axis. The shortcut key for 
invoking this tool is Y.

Z-Axis / Bank
This tool is used to lock or unlock the transformation along the Z axis. If this tool is 
chosen, the object will not move, scale, or rotate along the Z axis. The shortcut key for 
invoking this tool is Z.

Coordinate System
This is a toggle tool and is used to switch between Object and World coordinate systems 
for the movement, scaling, or rotation of an object. By default, Object coordinate system 

is activated in CINEMA 4D. It operates using the HPB system (Heading, Pitch, and Banking). 
The shortcut for invoking this tool is W.

Render View
This tool is used to render the currently active view.  On choosing this tool, the rendered 
output will be displayed in the active view. If you click in the rendered output, the active 
view will be displayed in the viewport. You can also choose this tool by pressing CTRL+R.

Render to Picture Viewer
This tool is used to render the scene in the Picture Viewer window. On choosing this 
tool, the Picture Viewer window will be displayed. The progress of the render and frame 

number being rendered will be displayed in the status bar of the Picture Viewer window. In 
CINEMA 4D, you can also render a region, make previews of the animations, and add scene 
to the render queue. To access these rendering options, press and hold the left mouse button 
on the Render to Picture Viewer tool; a flyout with various rendering options will be displayed, 
as shown in Figure 1-6. Next, choose the desired option from the flyout.

Edit Render Settings
This tool is used to invoke the Render Settings window. The options in this window are 
used to specify various settings to control the rendering process. In this window, you can 
set the size, quality, and so on of the scene that has to be rendered.

Cube
This tool is used to create a cube in the viewport. When you press and hold the left mouse 
button on the Cube tool, a flyout with various tools will be displayed, as shown in 
Figure 1-7. These tools are used to create the parametric objects in the scene.

Freehand
This tool is used to draw a freehand spline curve in the viewport. When you press and 
hold the left mouse button on the Freehand tool, a flyout with various spline modeling 
tools will be displayed, as shown in Figure 1-8. 
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Figure 1-6  The rendering options displayed in the flyout

Figure 1-7  The tools to create the parametric objects displayed in 
the flyout

Subdivision Surface
This tool is used to interactively subdivide and round the objects. This feature is very 
useful in organic modeling. When you press and hold the left mouse button on the 
Subdivision Surface tool, a flyout with various generators will be displayed, as shown in 

Figure 1-9. 

Array
This tool is used to create an array of objects in a spherical or wave form. When you press 
and hold the left mouse button on the Array tool, a flyout with special modeling tools 
will be displayed, as shown in Figure 1-10. These tools will be discussed in the later 
chapters.

Bend
This tool is used to bend a selected object in the specified direction. When you press and 
hold the left mouse button on the Bend tool, a flyout with various deforming tools will 
be displayed, as shown in Figure 1-11. 



1-8			                  MAXON CINEMA 4D R15 Studio: A Tutorial Approach
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 1-8  The spline modeling tools 
displayed in the flyout

Figure 1-9  The Generators 
displayed in the flyout

Figure 1-10  The special modeling tools displayed in the flyout

Figure 1-11  Various deforming tools displayed in the flyout

Floor
This tool is used to create a floor object in the viewport. When you press and hold the 
left mouse button on the Floor tool, a flyout with various tools will be displayed, as shown 
in Figure 1-12. 

Camera
This tool is used to add camera object in the scene. When you press and hold the left 
mouse button on the Camera tool, a flyout with various camera tools will be displayed, 
as shown in Figure 1-13. 
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Figure 1-12  Various tools displayed in the flyout

Light
This tool is used to add light objects to the scene. When you press and hold the left 
mouse button on the Light tool, a flyout with various light tools will be displayed, as 
shown in Figure 1-14. 

Figure 1-14   Various light tools 
displayed in the flyout

Figure 1-13  Various camera tools 
displayed in the flyout

Tools Palette
The Tools Palette is located on the extreme left of the interface, refer to Figure 1-3. It consists 
of various tools. These tools are discussed next.

Make Editable
This tool is used to convert primitive objects into polygon objects. By default, all the 
primitive objects and splines are parametric. The shortcut key for this tool is C.

Model
The Model tool is used to activate the Model mode. In this mode, you can move, scale, 
and rotate an object. When you press and hold the left mouse button on this tool, a 
flyout will be displayed. Choose the Object tool from the flyout to activate the Object 

mode. In this mode, you can move, scale, or rotate the axes of the object. The Object Mode 
is used when the animations are created.
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Texture
This tool is used to edit the active texture. When this tool is chosen, the projection type 
is also considered. The grid lines are drawn in the viewport according to the projection 
type. The texture can be moved, scaled, or rotated by using the Move, Scale, and Rotate 

tools.

Workplane
This tool is used to modify the workplane manually by using the Move, Rotate, and 
Scale tools. A workplane in CINEMA 4D is a plane that can be positioned and rotated 
for arranging newly created objects, snapping spline points, and so on.

Points
This tool is used to display the object in the Point mode. In this mode, you can select 
and edit the points of an object. On choosing this tool, the points of the object are 
displayed. This tool can be used only when an object is converted into a polygonal 
object.

Edges
This tool is used to display the object in the Edge mode. In this mode, you can select 
and edit the edges of an object. This tool can be used only when an object is converted 
into a polygonal object.

Polygons
This tool is used to display the object in the Polygon mode. In this mode, you can select 
and edit the polygons of  the selected object. This tool can be used only when an object 
is converted into a polygonal object.

Tip: To select one or more points, edges, or polygons, press and hold SHIFT and then click 
on them. To deselect one or more points, edges, or polygons, press and hold CTRL and then 
click on them.

Enable Axis 
The Enable Axis tool is used to move, scale, and rotate the axis of an object. The shortcut 
key for this tool is L.

Enable Snap
On choosing this tool, a flyout with various snapping tools will be displayed. You can 
snap objects, edges, points, and polygons.

Locked Workplane
The Locked Workplane tool is used to disable any defined automatic workplane modes. 
When you press and hold the left mouse button on this tool, a flyout will be displayed, 

as shown in Figure 1-15. You can use the tools in this flyout to align the workplane on different 
axes.
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Planar Workplane
The Planar Workplane tool is used to display one of the world coordinate planes as the 
workplane, depending on the angle of the view of the camera. When you press and hold 

the left mouse button on this tool, a flyout with various planar workplane tools will be displayed, 
as shown in Figure 1-16.

Figure 1-15  Flyout displayed on 
choosing the Locked Workplane 
tool

Figure 1-16   Flyout displayed on 
choosing the Planar Workplane 
tool

Animation Toolbar
The Animation toolbar is located below the viewport area. It consists of all animation controls 
that are used to control the animation in the scene, refer to Figure 1-17. These controls are 
discussed next.

Figure 1-17  The Animation toolbar

Timeline Ruler
The Timeline Ruler is located at the top of the Animation toolbar. You can move the timeslider 
on the Timeline Ruler to view the animation at a particular frame in the viewport.

Start Frame
The Start Frame spinner is used to set the first frame of the animation displayed in the 
Timeline Ruler.										       
	
End Frame
The End Frame spinner is used to set the last frame of the animation displayed in the 
Timeline Ruler.	
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Goto Start
The Goto Start button is used to move the timeslider to the start frame of the animation in 
the Timeline Ruler. Alternatively, you can press SHIFT+F to move the timeslider to the 
start frame.

Goto Previous Key
The Goto Previous Key button is used to move the timeslider backward by one keyframe 
from the current keyframe in the Timeline Ruler. Alternatively, you can press CTRL+F 
to move the timeslider backward from the last frame.

Goto Previous Frame
The Goto Previous Frame button is used to move the timeslider backward by one frame 
from the current frame in the Timeline Ruler. Alternatively, press F.

Play Forwards
The Play Forwards button is used to play the animation in the forward direction. 
Alternatively, you can press F8 to play the animation in the forward direction.

Goto Next Frame
The Goto Next Frame button is used to move the timeslider to the next frame in the 
Timeline Ruler. Alternatively, you can press G to move the timeslider to the next frame.

Goto Next Key
The Goto Next Key button is used to move the timeslider to the next keyframe in the 
Timeline Ruler. Alternatively, you can press CTRL+G to move the timeslider to the next 
keyframe.

Goto End 
The Goto End button is used to move the timeslider to the last frame. Alternatively, you 
can press SHIFT+G to move the timeslider to the last frame.

Record Active Objects
This button is used to create a key for the selected object on the current frame in the 
animation. By default, this button is not enabled. It is enabled only when an object is 
created in the viewport. Alternatively, you can press F9 to create a key for the selected 

object on the current frame.

Autokeying
The Autokeying button is used to set the keys automatically in the Timeline Ruler for 
the changes made in the animation. It saves the time of the user as the user need not 
manually choose the Record Active Objects button repeatedly to save the animation. 

Alternatively, you can press CTRL+F9 to set the keys automatically.
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Keyframe Selection
On choosing this tool, a flyout will be displayed with the tools that makes it possible to 
restrict the recording of a key to a specific object selection.  

Position
This button is used to record the position of the object on the current frame.

Scale
This button is used to record the scaling of the object on the current frame.

Rotation 
This button is used to record the rotation of the object on the current frame.

Parameter
This button is chosen to ensure that only the selected parameters are applied while 
recording keyframes. It works in both Automatic Keyframing and Record Active Objects 

modes.

Point Level Animation
This button is used to record the position of the points in the object. This mode only 
works with the polygonal objects.

Project
This button is used to set the playback rate to the value that is specified in the project 
settings. This button is enabled by default. When you press and hold the left mouse 
button on this button, a flyout will be displayed, as shown in Figure 1-18. This flyout 

consists of options to determine the playback speed of the animation.

Material Manager
The Material Manager is located at the bottom left corner of the interface, as shown in 
Figure 1-19. It is used to create materials and shaders used in the scene. 

Coordinate Manager
The Coordinate Manager is located at the right of the Material Manager, refer to Figure 1-20. 
It is used to position, rotate, and scale the objects created in the scene. You need to choose the 
Apply button to apply the values in the spinners of the Coordinate Manager.

Object Manager
The Object Manager is located at the upper right corner of the interface, as shown in 
Figure 1-21. It consists of a list of objects used in the scene. You can specify tags for objects, 
rename the objects, and select the objects in the Object Manager. Therefore, it is defined as 
the control center of the objects created in the scene.
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 Figure 1-19  The Material Manager Figure 1-18  The  flyout displayed 
on choosing the Project button

  Figure 1-21  The Object Manager  Figure 1-20  The Coordinate Manager

 

Attribute Manager
The Attribute Manager is used to display the attributes of a selected tool or object in the scene. 
You can also modify the attributes of the objects and materials in it. Moreover, you can set keys 
for animation to the attributes that have a circle next to their name. By default, it displays the 
project settings, as shown in Figure 1-22.

Layer Manager
The Layer Manager is used to manage the objects in layers when you need to work in complex 
scenes.  To invoke the Layer Manager, choose the Layers tab in the Attribute Manager; the 
Layer Manager will be displayed, as shown in Figure 1-23. 

Viewport Navigation Tools
The Viewport Navigation Tools are located on the top right corner of each viewport, refer to 
Figure 1-3. These tools are used to pan, zoom, and rotate the camera in the viewport. 
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  Figure 1-22  The Attribute Manager  Figure 1-23  The Layer Manager 

Pan Tool
The Pan tool is used to move the camera in X and Y directions in a scene. You can also 
pan the camera by pressing 1 along with the left mouse button or by pressing ALT along 

with the middle mouse button.

Zoom In/Out Tool
The Zoom In/Out tool is used to move the camera in the Z direction only. You can also 
zoom the camera by pressing 2 along with the left mouse button or by pressing ALT 

along with the right mouse button.

Orbit Tool
The Orbit tool is used to rotate the camera in all directions. You can also rotate the 
camera by pressing 3 along with the left mouse button or ALT along with the left mouse 

button.

Viewport Tool
The Viewport tool is used to toggle between four viewport and single viewport display. 

Note
You can maximize a viewport by pressing the middle mouse button inside that viewport.

Menu in editor view
The Menu in editor view is available in every viewport and is used to perform various tasks. 
It consists of  View, Cameras, Display, Options, Filter, and Panel menus, refer to Figure 1-3. 
These menus are discussed next.
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View Menu
On choosing the View menu, a flyout will be displayed, as shown in Figure 1-24. The options 
in this flyout are discussed next.

Figure 1-24  The flyout displayed on choosing the View menu

Use as Render View
The Use as Render View option is used to set the active viewport for rendering in the 
Picture Viewer window.

Undo View
The Undo View option is used to undo the last change made to the view angle in the 
viewport. 

Redo View
The Redo View option is used to redo the last change made to the view angle in the 
viewport. 

Frame All
The Frame All option is used to position the camera such that all objects including the 
lights and cameras fill the active viewport and are centered in it.

Frame Geometry
The Frame Geometry option is used to position the camera such that objects (excluding 
the lights and camera) are at the center of the viewport.

Frame Default
The Frame Default option is used to reset the viewport to its default value.

Frame Selected Elements
The Frame Selected Elements option is used to move the camera such that the selected 
objects and polygons are at the center of the viewport.

Frame Selected Objects
The Frame Selected Objects option is used to position the camera such that the 
active objects are at the center of the viewport.
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Film Move
The Film Move option is used to move the camera in the viewport.

Redraw
Usually CINEMA 4D updates the viewport automatically. However, sometimes it is not 
possible. In such a case, the Redraw tool is used to redraw the scene.

Cameras Menu
On choosing the Cameras menu, a flyout will be displayed, as shown in Figure 1-25. This 
flyout consists of various options, which are discussed next.

 Figure 1-25  The flyout displayed on choosing the Cameras menu

Navigation
On choosing the Navigation option, a cascading menu will be displayed, as shown in 
Figure 1-26. It displays various modes of the camera which are discussed next.

Figure 1-26  The cascading menu displayed on choosing the 
Navigation option from the Cameras menu
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       Cursor Mode: On choosing the Cursor Mode option, the camera will rotate around the 
selected point of the object.

Center Mode: On choosing the Center Mode option, the camera will rotate around the 
screen center only.

Object Mode: On choosing the Object Mode option, the camera will rotate around the 
center of the selected objects or elements in the viewport.

Camera Mode: On choosing the Camera Mode option, the camera will rotate around its 
own axis only.

Use Camera
The Use Camera option is used to set the camera present in the scene to view the scene 
through this camera. On placing the cursor on the Use Camera option in the Cameras 
menu, a cascading menu will be displayed, as shown in Figure 1-27. The Default Camera 
option is used to set the viewport back to the default camera settings.

Figure 1-27 The cascading menu displayed on choosing the 
Use Camera option

Set Active Object as Camera
The Set Active Object as Camera option is used to orient the view of the scene along the 
z-axis of the active object.
	
Perspective
The Perspective option is used to view the scene using the default perspective projection 
mode, as shown in Figure 1-28. The Perspective viewport shows a horizon line which 
represents the horizon at infinity.

Parallel
The Parallel option is used to view the scene using the parallel camera projection mode, 
as shown in Figure 1-29. In this type of camera projection, the projection lines are parallel 
to each other with an infinite focal length.



Exploring CINEMA 4D R15 Studio Interface		         1-19

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 1-28 The perspective camera 
projection mode

Figure 1-29  The parallel camera projection 
mode

Left
The Left option is used to display the YZ view, as shown in Figure 1-30.

Right
The Right option is used to display the ZY view, as shown in Figure 1-31.

  Figure 1-30  The left camera projection    Figure 1-31  The right camera projection

Front
The Front option is used to display the XY view, as shown in Figure 1-32.

Back
The Back option is used to display the YZ view, as shown in Figure 1-33.

Top
The Top option is used to display the XZ view, as shown in Figure 1-34.

Bottom
The Bottom option is used to display the ZX view, as shown in Figure 1-35.
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Figure 1-32  The front camera projection Figure 1-33  The back camera projection

Figure 1-35  The bottom camera projectionFigure 1-34  The top camera projection

Axonometric
The Axonometric option is used to display the scene using the advanced views other 
than the Perspective, Top, Left, and Right views. On placing the cursor on this option, a 
cascading menu will be displayed, as shown in Figure 1-36. The options in the cascading 
menu are discussed next.

Figure 1-36  The cascading menu displayed on choosing the 
Axonometric option from the Cameras menu
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Isometric: The Isometric option is used to view the scene using the isometric camera 
projection, as shown in Figure 1-37. In this type of camera projection, the projection lines 
are in exact proportion. This projection is mostly used for technical objects.

Dimetric: The Dimetric option is used to view the scene using the dimetric camera 
projection, as shown in Figure 1-38. The Dimetric option is similar to the Isometric 
option but the proportion of XYZ in this case is 1:1:0.5.

 Figure 1-37  The isometric camera projection Figure 1-38  The dimetric camera projection

Military: The Military option is used to view the scene using the military camera projection, 
as shown in Figure 1-39. The proportion of XYZ in this case is 1:1:1.

Figure 1-39  The military camera projection

Gentleman: The Gentleman option is used to view the scene using the gentleman camera 
projection, as shown in Figure 1-40. This type of projection is suitable for architecture. 
The proportion of the XYZ in this case is 1:1:0.5.

Bird: The Bird option is used to view the scene using the bird camera projection, as shown 
in Figure 1-41. In this type of camera projection, the projection lines will have no perspec-
tive distortion and the objects are not scaled. The proportion of XYZ in this case is 1:0.5:1.
Frog: The Frog option is used to view the scene using the frog camera projection, as shown 
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in Figure 1-42. In this type of camera projection, the projection lines are not parallel to 
each other. The proportion of XYZ in this case is 1:2:1.

  Figure 1-41  The bird camera projectionFigure 1-40  The gentleman camera 
projection

Display Menu
On choosing the Display menu, a flyout will be displayed, as shown in Figure 1-43. It consists 
of various options that are used to manipulate the preview of the model in the viewport. These 
options are discussed next.

Figure 1-42  The frog camera projection Figure 1-43  The flyout displayed on choosing 
the Display menu

Gouraud Shading
The Gouraud Shading option is used to display the object in best quality possible. On 
choosing this option, the object in the viewport will be displayed with smooth shading 
and lights, as shown in Figure 1-44.



Exploring CINEMA 4D R15 Studio Interface		         1-23

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Gouraud Shading (Lines)
The Gouraud Shading (Lines) option is used to display the object with smooth shading 
and wireframes or isoparms, as shown in Figure 1-45.

 

Figure 1-44  The object displayed in 
the viewport on choosing the Gouraud 
Shading option

Figure 1-45 The object displayed in the 
viewport on choosing the Gouraud Shading 
(Lines) option

Quick Shading
The Quick Shading option is used to display the object with smooth shading and default 
lights instead of the scene lights in the viewport, as shown in Figure 1-46.

Quick Shading (Lines)
The Quick Shading (Lines) option is used to display the object with smooth shading, wire-
frames or isoparms, and default lights instead of the scene lights, as shown in Figure 1-47.

Figure 1-46  The object displayed in the 
viewport on choosing the Quick Shading 
option

Figure 1-47  The object displayed in the 
viewport on choosing the Quick Shading 
(Lines) option

Constant Shading
The Constant Shading option is used to illuminate an object with flat shades, as shown 
in Figure 1-48.

Constant Shading (Lines)
The Constant Shading (Lines) option is used to display the object with flat shades along 
with the wireframes added to it, as shown in Figure 1-49.
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Figure 1-48  The object displayed in 
the viewport on choosing the Constant 
Shading option

Figure 1-49  The object displayed in 
the viewport on choosing the Constant 
Shading (Lines) option

Hidden Line
The Hidden Line option is used to display the polygon mesh, excluding the hidden lines 
of the object, as shown in Figure 1-50.

Lines
The Lines option is used to display the polygon mesh in the wireframe mode, including 
the hidden lines of the object, as shown in Figure 1-51.

Figure 1-50  The object displayed in the 
viewport on choosing the Hidden Line 
option

Figure 1-51  The object displayed in 
the viewport on choosing the Lines 
option

Wireframe
The Wireframe option is used to display the polygon 
mesh along with the lines so that the object is displayed 
with the combination of other shading modes. To 
activate this option, you need to choose any of the 
display options along with it. Figure 1-52 displays the 
object in the Quick Shading (Lines) and Wireframe 
shading modes.

Isoparms
The Isoparms option is used to display the isoparms 
lines for the object that use them such as the 
Generators. 

Figure 1-52  The object displayed in 
the Wireframe and Quick Shading 
(lines) shading modes
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Box
The Box option is used to display each object in a box shape having same dimensions 
as that of the object.

Skeleton
The Skeleton option is used to display the objects in the form of dots. This option is the 
fastest display mode and is used to display the hierarchical structure. This mode is used 
in character animation.

Options Menu
On choosing the Options menu, a flyout will be displayed, as shown in Figure 1-53. It consists 
of various options that are used to display the detail view of a model. These options are 
discussed next.

Level of Detail
The Level of Detail option is used to affect the display quality of the object in the viewport. 
On placing the cursor on the Level of Detail option, a cascading menu will be displayed, 
as shown in Figure 1-54. The options in this cascading menu are discussed next.

Figure 1-53  The flyout displayed on choosing 
the Options menu

Figure 1-54  The cascading menu displayed on 
placing the cursor on the Level of Detail option

Low: This option is used to display the objects with low details, upto 25% maximum. When 
you choose this option, the object takes very less time in getting displayed in the viewport.

Medium: This option is used to display the objects with medium detail, upto 50% 
maximum.

High: This option is used to display the objects with highest details upto 100 %.  When 
you choose this option, the object takes more time in getting displayed in the viewport.
Use Render LOD for Editor Rendering: This option is used to render the object in the 
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viewport with the same level of detailing as specified in the Level of Detail option for 
that viewport. 

Stereoscopic
The Stereoscopic option is used to enable stereoscopic display for viewport. This option 
is activated only in the Perspective and Parallel viewports.

Linear Workflow Shading
The Linear Workflow Shading option is used to control the display of colors and shaders 
in the viewport while following the linear workflow.

Enhanced OpenGL
This option is used to display objects in the scene with Enhanced OpenGL quality. This 
option is dependent on the type of graphics card and drivers installed in the system. There 
are five OpenGL display modes available in the viewport in CINEMA 4D.

Noises
The Noises option is used to display the Noise shader when the Enhanced OpenGL 
option is enabled.

Post Effects
The Post Effects option is used to display post effects when the Enhanced OpenGL 
option is enabled.

Shadows
The Shadows option is used to display the shadow when the Enhanced OpenGL option 
is enabled.

Transparency
The Transparency option is used to display the transparency in high quality when 
Enhanced OpenGL option is enabled.

Backface Culling
The Backface Culling option is used to toggle the backface culling on or off in the lines 
mode. It makes the editing of the objects easier. Figure 1-55 displays the object with 
Backface Culling on and off.

Figure 1-55  The object displayed with the Backface Culling option on and off 
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Isoline Editing
The Isoline Editing option is used to project all subdivision surface cage objects onto the 
smooth subdivision surface object such that these elements can be selected directly on 
the smoothened object. Figure 1-56 displays the object with the Isoline Editing option 
on and off.

 Figure 1-56  The object displayed with the Isoline Editing option on and off 

Layer Color
The Layer Color option makes the color of the object in the viewport same as the color 
of the layer to which it belongs. For example, if the color of the layer is green, then the 
object belonging to that layer will be displayed in green color, refer to Figure 1-57. This 
makes the selection of the objects easier.

Figure 1-57  The color of the objects displayed same as the 
color of layers on choosing the Layer Color option

Normals
The Normals option is used to toggle the display of normals in the polygon mode. When 
this option is activated, normals of the selected polygons of the object are displayed in 
the viewport, as shown in Figure 1-58.

Tags
The Tags option is used to display the selected object in the display mode defined in their 
display tag. On choosing this option, you can edit the display settings of a selected object 
individually in the Attribute Manager. To add a tag to the Object Manager, right-click on 
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the object, a shortcut menu will be displayed. From the 
shortcut menu, choose CINEMA 4D Tags > Display; a 
display tag will be added to the Object Manager. Now, 
select the Display Tag in the Object Manager to edit 
the display settings.

Textures
The Textures option is used to toggle the view of the 
textures in the viewport. Realtime Texture Mapping 
(RTTM) allows the viewing of the texture applied to 
the object in the viewport.

X-Ray
The X-Ray option is used to display the polygon objects 
in a semi-transparent color so that the points and edges 
can be tweaked easily in the polygon based modeling.

Default Light
The Default Light option is used to illuminate the object 
easily from any angle. Each viewport has its own independent 
default lighting system. On choosing this option, the Default 
Light window will be displayed, as shown in Figure 1-59. Click 
and drag the sphere in the Default Light window to adjust 
the light in the viewport. When you choose this option, the 
display mode automatically changes to Quick Shading. Figure 1-59  The Default 

Light window
Configure
The Configure option is used to edit or control the parameters of a particular viewport 
in the Attribute Manager.

Configure All
	 The Configure All option is used to edit or control the parameters of all viewports in the 

Attribute Manager. 

Filter Menu
On choosing the Filter menu, a flyout will be displayed. The options in this flyout are used 
to select the objects to be displayed in the respective viewports. 

Panel Menu
On choosing the Panel menu, a flyout will be displayed, as shown in Figure 1-60. The option 
in this menu is used to choose between single or multiple views of viewports. By default, the 
Perspective viewport will be displayed.

Figure 1-58  Displaying the normals 
of the selected polygons
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Layout
The Layout drop-down list is located on the top right corner of the interface, as shown in 
Figure 1-61. The options in this drop-down list are used to switch between various layouts 
available in CINEMA 4D. You can select the required layout from this drop-down list. 

Figure 1-60  The flyout displayed 
on choosing the Panel menu

Figure 1-61 The Layout 
drop-down list

Content Browser
The Content Browser is an integral part of CINEMA 4D. It is used to manage scenes, images, 
materials, shaders, and presets. The Content Browser is docked with the Object Manager in 
CINEMA 4D interface.

 

Structure Manager
The Structure Manager is a type of spreadsheet that is used to calculate the data. It displays 
the data of the polygon objects only. On converting the parametric object into a polygon 
object, the data of the points, polygons, UVW coordinates, and so on will be displayed in the 
rows and columns of the Structure Manager. The Structure Manager is docked with the Object 
Manager and Content Browser in CINEMA 4D interface.
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HOT KEYS
Table 1-1 displays the hot keys of tools used in CINEMA 4D.

 Table 1-1 The tools and their hot keys

Tool Hot keys

Undo CTRL+Z

Redo CTRL+Y

Move E

Scale T

Rotate R

X-Axis / Heading X

Y-Axis / Pitch Y

Z-Axis / Bank Z

Coordinate System W

Render View CTRL+R

Render to Picture Viewer SHIFT+R

Edit Render Settings CTRL+B

Make Editable C

Undo View CTRL+SHIFT+Z

Redo View CTRL+SHIFT+Y

Tip: If you want to view the documentation of a tool or option in CINEMA 4D, place 
the cursor over that tool or option and then press CTRL+F1; the Help window will be 
displayed with the documentation.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Which of the following options is used to display the polygon objects in a semi-transparent 
mode?

  		
		  (a) Display Tags		  (b) Textures
  		  (c) X-Ray			   (d) Default Light
	
2.	 Which of the following shortcut keys is used to convert the primitive objects into editable 

objects?  
		
		  (a) A				    (b) C
  		  (c) B				    (d) D
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3.   Which of the following combinations of shortcut keys is used to render the current view? 
  		
		  (a) CTRL+W			   (b) CTRL+D
  		  (c) CTRL+R			   (d) CTRL+ J

4.	 The __________ tool is used to add light objects to a scene.

5. 	 The __________ tool is used to select sub-objects of an editable object like a paint brush 
in the viewport. 

	
6.   	The __________ button is used to move the timeslider to the start of the animation.

7.   The shortcut key for the Autokeying button is ___________ .

8.	 The shortcut key for the Redo tool is CTRL+Z. (T/F)

9.	 The Bend tool is used to create an array of objects in a spherical or a wave form. (T/F)

10.	 The Object Manager is defined as the control center of the objects created in the scene.  
(T/F)  

 Review Questions 
Answer the following questions:

1.	 Which of the following tools from the Tools Palette is used to edit the polygons of the 
selected object?

  		
		  (a) Points	 		  (b) Edges
  		  (c) Polygons	 		  (d) Model

2.	 Which of the following keys is the shortcut for the Rotate tool?  		
		
		  (a) E				    (b) R
  		  (c) T				    (d) W

3.  	 Which of the following options in the Options menu is used to edit or control the 
parameters of all viewports in the Attribute Manager?

		  (a) Configure All		  (b) Normals
  		  (c) Backface Culling		  (d) Configure

4. 	 The __________ option in the Options menu is used to enable the stereoscopic display 
in the viewport individually.

5.    The __________ tool is used to move the camera horizontally.
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6.   The Attribute Manager is used to control the attributes of a selected tool or object in the 
scene. (T/F)

7.   Snapping cannot be performed on objects, edges, points, polygons, and model. (T/F)

8.	 You can use the Frog camera projection in the Cameras menu to view the parallel camera 
projection in a scene. (T/F)

9. The shortcut key to invoke the Render Settings window is CTRL+B. (T/F)

												          
												          
												          
												          
												          
												          
												          
												          
												          
												          
												          
												          
												          
												          

Answers to Self-Evaluation Test
1. c, 2. b, 3. c, 4. Light, 5. Live Selection, 6. Goto Start, 7. CTRL+F9, 8. F, 9. F, 10. T


